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1 Preface 

1.1 Introduction to the PLX51-DF1-MSG 

This document describes the installation, operation, and diagnostics of the ProSoft 
Technology PLX51-DF1-MSG DF1 Messenger. The PLX51-DF1-MSG provides 
intelligent data routing between EtherNet/IP and DF1 which can help simplify the 
migration from PLC2, PLC3, PLC5, and SLC systems to ControlLogix or CompactLogix 
platforms, where a DF1 interface is required. 

 

 

Figure 1.1 – Migration Path  
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1.2 Features 

The PLX51-DF1-MSG can transfer data from a DF1 device to a maximum of eight Logix 
controllers. The module operates in one of three modes, simplifying the configuration for 
all applications. 

Mode Message Initiator Description 

DF1 Slave Remote Device The PLX51-DF1-MSG converts DF1 messages to Logix 

controller tag reads or tag writes.  

No Logix PLC Mapping configuration is required. 

Scheduled Tag PLX51-DF1-MSG  The PLX51-DF1-MSG transfers data between a DF1 device 

and Logix tags, using a preconfigured schedule. 

No Logix or remote device configuration is required. 

Table 1.1 – Modes of Operation 

 

The PLX51-DF1-MSG is configured using the ProSoft PLX50 Configuration Utility. This 
program can be downloaded from www.prosoft-technology.com free of charge. The 
PLX50 Configuration Utility offers various configuration methods, including a controller 
tag browser. 

Hereafter the PLX51-DF1-MSG will be referred to as the module. 

The module can operate in both a Logix “owned” and standalone mode. With a Logix 
connection, the input and output assemblies will provide additional diagnostics 
information which will be available in the Logix controller environment.  

The module uses isolated RS232 for DF1 communication providing better noise 
immunity. The RS232 port also uses a terminal block for convenient installation.  The 
module can also be used in systems with redundant DF1 pathways. 

A built-in webserver provides detailed diagnostics of system configuration and operation, 
including the display of received DF1 communication packets, without the need for any 
additional software.  

 
 
 
 
 
 

  

http://www.prosoft-technology.com/
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1.3 Architecture 

The figure below provides an example of the typical network setup.  

 

 

Figure 1.2 – Example of a typical network setup 

 

By converting and redirecting serial DF1 messages from legacy devices to EtherNet/IP, 
the module provides an interface for data exchange to ControlLogix and CompactLogix 
platforms.  

When connected to devices that provide more than one DF1 port, it is possible to 
implement DF1 communication redundancy with the use of two PLX51-DF1-MSG’s. 
These can be configured in one of two modes; Simultaneous or Active / Standby. 

In the Simultaneous mode, both modules route the same traffic to the same Logix 
controller. Effectively, the Logix controller will receive two of each message and process 
both of them.  

Active / Standby mode requires both modes to be Logix “Owned”. One of the modules 
has its routing capability disabled, achieved by setting the Inhibit Routing bit in the output 
assembly. Logic in the Logix controller can monitor the connection and performance of 
the Active module and, if necessary, inhibit the Active module and un-inhibit the Standby 
module. 
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Figure 1.3 – Redundant Architecture 

The PLX51-DF1-MSG can be used in redundant Logix controller systems.  

Systems that rely on a central ControlLogix communicating to a number of remote DF1 
devices, e.g. MicroLogix and SLC stations, may find the PLX51-DF1-MSG useful when 
upgrading to newer ControlLogix processors, which no longer have a serial port. These 
systems can easily be upgraded using the PLX51-DF1-MSG without affecting the 
existing and often costly wireless infrastructure. 

 

Figure 1.4 – Remote MicroLogix System 



PLX51-DF1-MSG  Preface 
DF1 Messenger  User Manual 

 

ProSoft Technology, Inc. Page 9 of 61 
 

1.4 Additional Information 

The following documents contain additional information that can assist you with the 
module installation and operation. 

Information Source 

PLX50 Configuration Utility Software www.prosoft-technology.com 

PLX51-DF1-MSG User Manual www.prosoft-technology.com 

PLX51-DF1-MSG Datasheet www.prosoft-technology.com 

Example Code & UDTs www.prosoft-technology.com 

Ethernet wiring standard www.cisco.com/c/en/us/td/docs/video/cds/cde/cde205_220_420/in

stallation/guide/cde205_220_420_hig/Connectors.html 

CIP Routing The CIP Networks Library, Volume 1, Appendix C: Data 

Management 

Map PLC/SLC messages • SLC to CompactLogix Migration Guide: Chapter 3 – Map 

PLC/SLC Messages (1769-ap001_-en-p.pdf) 

• EtherNet/IP Network Configuration: Chapter 5 – Mapping Tags 

(enet-um001_-en-p.pdf) 

Table 1.2 – Additional Information 

For users in the European Union: 

If you wish to discard electrical and electronic equipment (EEE), please contact your dealer or supplier 
for further information. 

 

https://www.prosoft-technology.com/
https://www.prosoft-technology.com/
https://www.prosoft-technology.com/
https://www.prosoft-technology.com/
https://aparian1.sharepoint.com/ProductDevelopment/Documentation/PLX51-DF1-MSG/20230725/www.cisco.com/c/en/us/td/docs/video/cds/cde/cde205_220_420/installation/guide/cde205_220_420_hig/Connectors.html
https://aparian1.sharepoint.com/ProductDevelopment/Documentation/PLX51-DF1-MSG/20230725/www.cisco.com/c/en/us/td/docs/video/cds/cde/cde205_220_420/installation/guide/cde205_220_420_hig/Connectors.html
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2 Installation 

2.1 Module Layout 

The PLX51-DF1-MSG has three ports at the bottom of the enclosure. The ports are used 
for Ethernet, RS232 serial, and power. 

The power port uses a three-way connector which is used for the DC power supply; 
positive and negative (or ground) voltage, as well as the earth connection. 

The RS232 port uses a four-way connector. This provides connection for the 
communication transmit (TX), receive (RX), and ground (GND) conductors. The fourth 
connection is used for shielding the cable in high-noise environments.  

 

 

 
 

Figure 2.1 – PLX51-DF1-MSG side and bottom view 
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2.2 LEDs 

The module provides three diagnostic LEDs that provide information regarding the 
module system operation, the Ethernet interface, and the auxiliary communication 
interface (RS232). 

 

      

Figure 2.2 – PLX51-DF1-MSG front and top view 

2.3 DIP Switches 

The module provides four DIP switches at the top of the enclosure as shown in Figure 
2.2.  

 
DIP Switch Description 

DIP Switch 1 Used to force the module into “Safe Mode”. When in “Safe Mode”, the module will not 

load the application firmware and will wait for new firmware to be downloaded. This 

should only be used in the rare occasion when a firmware update was interrupted at a 

critical stage.  

DIP Switch 2 This will force the module into DHCP mode which is useful when you have forgotten 

the IP address of the module. 

DIP Switch 3 Used to lock the configuration from being overwritten by the PLX50 Configuration 

Utility. When set to ‘On’, the PLX50 Configuration Utility will not be able to download 

to the module. 

DIP Switch 4 Upon bootup, the Ethernet IP address will be set to 192.168.1.100 and network mask 

255.255.255.0. The DIP switch can then be set to ‘Off’ to allow the assignment of a 

static IP address, if needed. 

Table 2.1 – DIP Switch Settings 
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2.4 Module Mounting 

The module provides a DIN rail clip to mount onto a 35mm DIN rail.  

 

 

Figure 2.3 – DIN rail specification 

 

The DIN rail clip is mounted on the bottom of the module, toward the back. Use a flat 
screwdriver to pull the clip downward. This will enable you to mount the module onto the 
DIN rail. Once the module is mounted onto the DIN rail, the clip must be pushed upward 
to lock the module onto the DIN rail. 

 

 

Figure 2.4 – DIN rail mouting 
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2.5 Power 

A three-way power connector is used to connect Power+, Power– (GND), and earth. The 
module requires an input voltage of 10 to 28 VDC. For more information on electrical 
requirements, please see page 60.  

 

 

Figure 2.5 – Power connector 

2.6 RS232 Port 

The four-way RS232 connector is used to connect the transmit (TX), receive (RX), and 
GND conductors for serial communication. The shield terminal can be used for shielded 
cable in high noise environments.  

Note: The shield of the RS232 port is internally connected to the power connector earth. Thus, when using 
a shield it is important to connect the Earth terminal on the power connector to a clean earth. Failing to do 
this can lower the signal quality of the RS232 communication. 

 

Note: When using a shielded cable, it is important that only one end of the shield is connected to earth to 
avoid current loops. It is recommended to connect the shield to the PLX51-DF1-MSG module, and not to the 
other DF1 device. 

  

 

Figure 2.6 – RS232 connector 

2.7 Ethernet Port 

The Ethernet connector should be wired according to industry standards. Refer to the 
Ethernet section on page 60 for further details. 
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3 Setup 

3.1 Install Configuration Software 

The network setup and configuration of the PLX51-DF1-MSG is done in the ProSoft 
PLX50 Configuration Utility. This software can be downloaded from www.prosoft-
technology.com. 

 

 

Figure 3.1 – ProSoft PLX50 Configuration Utility Environment 

   

  

http://www.prosoft-technology.com/
http://www.prosoft-technology.com/
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3.2 Network Parameters 

The module has DHCP (Dynamic Host Configuration Protocol) enabled as factory 
default. A DHCP server must be used to provide the module with the required network 
parameters (IP address, subnet mask, etc.). There are a number of DHCP utilities 
available, however it is recommended to use the DHCP server in the PLX50 
Configuration Utility. 

3.2.1 DHCP Server Configuration 

Within the PLX50 Configuration Utility environment, the DHCP SERVER option can be 
found under the Tools menu. 

 

 

Figure 3.2 – Selecting DHCP Server 

Once opened, the DHCP server will listen on all available network adapters for DHCP 
requests and display their corresponding MAC addresses. 

 

Figure 3.3 – DHCP Server 

Note: If the DHCP requests are not displayed in the DHCP Server, it may be due to the local PC’s firewall. 
During installation the necessary firewall rules are automatically created for the Windows firewall. Another 
possibility could be another DHCP Server is operational on the network and has assigned the IP address. 
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To assign an IP address, click on the corresponding ASSIGN button. The Assign IP 
Address for MAC dialog opens. 

 

 

Figure 3.4 – Assigning IP Address 

The required IP address can then be either entered, or a recently used IP address can 
be selected by clicking on an item in the Recent List. 

If the ENABLE STATIC checkbox is checked, then the IP address will be set to static after 
the IP assignment, thereby disabling future DHCP requests. 

Once complete, the DHCP server will automatically assign the IP address to the module 
and then read the Product name from the device.  

The successful assignment of the IP address by the device is indicated by the green 
background of the associated row. 

 

 

Figure 3.5 – Successful IP address assignment 

It is possible to force the module back into DHCP mode by powering up the device with 
DIP switch 2 set to the ON position. A new IP address can then be assigned by 
repeating the previous steps.  

Note: It is important to return DIP switch 2 back to OFF position to avoid the module returning to a DHCP 
mode after the power is cycled again. 

In addition to the setting the IP address, other network parameters can be set during the 
DHCP process. These settings can be viewed and edited in the PLX50 Configuration 
Utility APPLICATION SETTINGS, in the Tools tab. 
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3.2.2 Ethernet Port Configuration 

Once the DHCP process has been completed, the network settings can be set using the 
Ethernet Port Configuration via the TARGET BROWSER option. 

The TARGET BROWSER can be accessed under the Tools menu. 

 

Figure 3.6 – Selecting the Target Browser 

The Target Browser automatically scans the Ethernet network for EtherNet/IP devices. 

 

Figure 3.7 – Target Browser 

Right-clicking on a device, reveals the context menu, including the PORT CONFIGURATION 
option. 

 

Figure 3.8 – Selecting Port Configuration 
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The Ethernet port configuration parameters can be modified using the Ethernet Port 
Configuration dialog. 

 

Figure 3.9 – Port Configuration 

 

Alternatively, these parameters can be modified using RSLinx. 
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3.3 Creating a New Project 

Before the module is configured, a new PLX50 Configuration Utility project must be 
created. Under the File menu, select NEW. 

 

 

Figure 3.10 – Creating a new project 

 

A PLX50 Configuration Utility project will be created, showing the Project Explorer tree 
view. To save the project use the SAVE option under the File menu. 

Select ADD under the Device menu. 

 

 

Figure 3.11 – Adding a new device 
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 In the Add New Device dialog, select the PLX51-DF1-MSG, and click the OK button.  

 

 

Figure 3.12 – Selecting a new PLX51-DF1-MSG 

 

The device appears in the Project Explorer tree, with its configuration dialog opened.  

The DF1 Messenger – Configuration dialog can be reopened by either double-clicking 
the module in the Project Explorer tree or right-clicking the module and selecting 
CONFIGURATION. 

 

 

Figure 3.13 – PLX51-DF1-MSG configuration 
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3.4 DF1 Parameters 

The DF1 parameters are configured by the PLX50 Configuration Utility. The DF1 
Messenger - Configuration dialog consists of a general configuration as well as a serial 
configuration. The configuration is stored in non-volatile memory that persists when the 
module is powered down.  

Note: When a firmware upgrade is performed, the module will clear all DF1 configuration and routing maps.  

 
The DF1 Messenger - Configuration dialog is opened by either double-clicking on the 
module in the tree, or right-clicking the module and selecting CONFIGURATION. 

 

 

Figure 3.14 – General Configuration 

The General tab configuration consists of the following parameters: 

Parameter Description 

Instance Name This parameter is a user defined name to identify between various PLX51-DF1-

MSG’s. 

Description This parameter is used to provide a more detailed description of the application for the 

PLX51-DF1-MSG.  

IP Address The IP address of the PLX51-DF1-MSG. 

Major Revision The major revision of the PLX51-DF1-MSG. 

ENIP Retry 

Limit 

The amount of EtherNet/IP retries the module will make once no response was 

received from the Logix Controller. 
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ENIP TimeOut The time, in milliseconds, after which a retry is sent. Once the first retry is sent, the 

next retry will be sent after the same amount of time. This will repeat until the ENIP 

Retry Limit is reached. 

Operating Mode The Operating Mode determines how the DF1 messages are routed.  

 

In DF1 SLAVE mode, the module automatically routes the DF1 message and function 

to the correct Logix tag. In this mode, the PLX51-DF1-MSG maps the DF1 request to 

the preconfigured tag.  

Communication in this mode is initiated by the remote DF1 device. 

 

In SCHEDULED mode, the PLX51-DF1-MSG initiates the exchange between the remote 

DF1 device and Logix. Either by reading data from a DF1 device and writing it into a 

preconfigured Logix tag, or vice versa.  

Communication in this mode is initiated by the PLX51-DF1-MSG. 

 

Refer to the Message Routing section on page 24 for an explanation of the routing 

operation. 

Table 3.1 – General configuration parameters 

 

The Serial-DF1 configuration is shown in the figure below: 

 

Figure 3.15 – Serial DF1 configuration 
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The Serial – DF1 tab consists of the following parameters: 

Parameter Description 

Protocol The protocol parameter configures the module to operate in full duplex, half duplex, or 

Radio Modem mode on the DF1 network. 

BAUD Rate The BAUD rate configures at what speed the data is sent across the RS232 serial 

network. The module provides the following speeds: 

1200, 2400, 4800, 9600, 19200, 38400, 57600, and 115200 

Parity The parity parameter configures the parity of the module’s RS232 serial port. The 

module allows for Even, Odd, or None parity setting. 

Error Detection The module can be configured to perform either BCC or CRC checksum validation on 

incoming and outgoing packets. CRC checksums is a much stronger validation 

method when compared to BCC but is more processor intensive to perform. 

Embedded 

Response 

This parameter configures the module to add the acknowledge responses in the data 

payload. You can configure the module to be AUTO DETECT or ON. 

This function is only available in Full Duplex mode. 

Node Address The node address is dynamically changed to suite the required mapping. 

Retry Limit The retry limit determines how many times the module must retry and message 

exchange before failing it. 

ACK Timeout The ACK timeout is used to determine the interval between retries when a message 

exchange has failed. 

Reply Message 

Delay 

This is the minimum delay before the DF1 reply is transmitted to the DF1 device. 

Duplicate 

Detection 

This parameter checks for duplicate packets and flagging them when they occur. 

Enable Store 

and Forward 

When using the Radio Modem protocol, the PLX51-DF1-MSG can be used to repeat 

messages from other nodes on the radio network (only relevant for DF1 Radio Modem 

protocol).  

Repeat Delay When repeating packets from other nodes on the Radio network, this setting 

determines the delay before repeating the packet (only relevant for DF1 Radio Modem 

protocol).  

Nodes to 

Repeat 

When Store and Forward has been enabled, the Nodes to Repeat list is all the nodes 

numbers of the devices from which the PLX51-DF1-MSG must repeat the messages 

(only relevant for DF1 Radio Modem protocol). 

Table 3.2 – Serial DF1 configuration parameters 
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3.5 Message Routing 

The module can be configured to route DF1 data in one of two modes: 

• DF1 Slave mode 

• Scheduled mode 

3.5.1 DF1 Slave Mode 

The DF1 Slave mode allows the mapping of virtual Data Files to Logix tags across 
multiple controllers. The mapping of data files to Logix tags is managed in the PLX51-
DF1-MSG.  

The routing of the Node address to Logix controller as well as DF1 File Number to a 
Logix tag is managed by the PLX51-DF1-MSG. In the DF1 Slave mode, the PLX51-DF1-
MSG can operate independently from the Logix controller by directly reading and writing 
to Logix tags.  

Note: The DF1 Slave mode only works with PLC5, SLC Typed Read and Write messages, as well as PLC2 
Unprotected Read and Write messages. 

 

1 Create a Target Name (CIP path to the destination Logix controller) to be used to 
link the DF1 File Number to the destination Logix tag.  

Note: When using PLC2 messages, the Target will be linked to the DF1 Node Number. If the 
device sending out PLC2 requests wants to access multiple Target Tags, it will need to differentiate 
by using different Node Numbers. 

 

 

Figure 3.16 – DF1 Slave mode configuration 
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2 The Logix Controller Path can be entered manually, or browsed to by clicking the 
BROWSE button. The Target Browser will open and automatically scan for all 
available EtherNet/IP devices. If the EtherNet/IP module is a bridge module, it 
can be expanded by right-clicking on the module and selecting the SCAN option. 

 

 

Figure 3.17 – Scanning node in the Target Browser 

 

 

Figure 3.18 – Target Browser selection 

Select the controller by either highlighting and clicking the OK button, or double-
clicking on the controller icon. 

A maximum number of 8 controller mapping entries can be added.  
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3 Next, configure the link between a DF1 Node and File Number combination to a 
Logix tag. This allows the DF1 message initiator to effectively write to, or read 
from, a Logix tag using traditional File Numbers (e.g. N7, F8, etc.).  

 

Figure 3.19 – DF1 Slave Mapping 

Note: When using PLC-2 messages, enter PLC2 in the Data File field as shown below. Only the 
DF1 Node address will be used to link the selected Target Tag to the incoming PLC2 DF1 
message. 

 

 

Figure 3.20 – DF1 Slave Mapping (PLC2 Messages) 
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Note: When using Unprotected Bit Write PLC-2 messages, only one byte worth of bits can be 
written at a time. 

The module can emulate more than one destination DF1 Node Address and can 
route multiple messages to different Logix controllers. It is important to enter the 
correct associate DF1 Node address in each mapping record. 

4 The next column is used to enter the DF1 Data File. It is important to enter only 
the file here (e.g. N11) and not a data word address (e.g. N11:0). The first 
element of the entered DF1 file (e.g. N11:0) will map to the first element of the 
Logix array and so on. When using PLC2 messages, enter PLC2 into the Data 
File field. 
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3.5.1.1 Target Tag Selection 

The Target Tag can be either entered manually or selected using the Logix Tag Browser 
dialog in the PLX50 Configuration Utility. The Logix Tag Browser requires the controller 
to be available on the network.  

To browse to the tag, click on the BROWSE button. The Logix Tag Browser dialog opens 
and scans all the tags inside that controller. If the controller has been recently scanned 
in this session, then a cached version of the tags is displayed. A rescan of the tags can 
be triggered by selecting the REFRESH button in the Logix Tag Browser’s toolbar. 

Note: When mapping PLC5 Boolean files (e.g. B3), it is recommended that the destination Logix tag be a 
SINT array. 

 

Note: When mapping PLC2 messaging, only INT datatypes will be supported. The Target Tag must be an 
array of INTs. 

 

 

Figure 3.21 – Tag Browser tag selection 
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The following example shows how DF1 messages are routed to the Logix tags using the 
DF1 Slave Map mode.  

Note: Ensure the Logix tag array datatype and size matches that of the DF1 File Number. Failing to do this 
can result in communication faults.   

 

Figure 3.22 – DF1 Slave mode configuration in the PLX50 Configuration Utility 
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3.5.2 PLC2 Messaging 

When receiving PLC2 messages, the Data File entered in the PLX50 Configuration 
Utility will be “PLC2” because there are no Data Files in PLC2 message structures. The 
DF1 Node address will be used to route the messages as shown below: 

Note: Ensure the Logix tag array datatype and size matches that of the PLC2 DF1 request. Failing to do this 
can result in communication faults.   

 

 

Figure 3.23 – DF1 Slave mode config in the PLX50 Configuration Utility (PLC2 messages) 
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3.5.3 Scheduled Mode 

The Scheduled routing mode transfers data between a DF1 device and one or more 
Logix controllers (the PLX51-DF1-MSG initiates the messaging when in the Scheduled 
mode). 

In this mode, the PLX51-DF1-MSG transfers data between a Logix controller and a DF1 
device without any configuration or programming required in either the DF1 device or the 
Logix controller. 

 

 

Figure 3.24 – Scheduled configuration 

 

1 Create a Target Name (CIP path to the destination Logix controller) which will be 
used to link the DF1 File Number to the destination Logix tag.  

2 The Logix controller paths can either be entered manually or can be browsed by 
clicking the BROWSE button. The Target Browser dialog opens and automatically 
scans for all available EtherNet/IP devices. 
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If the EtherNet/IP module is a bridge module, it can be expanded by right-clicking 
on the module and selecting the SCAN option. 

 

 

Figure 3.25 – Scanning node in the Target Browser 

 

 

Figure 3.26 – Target Browser selection 

The required Logix controller can be chosen by selecting it and clicking the Ok 
button, or by double-clicking on the controller module. 

A maximum number of 8 controller mapping entries can be added.  

3 Next, configure the scan intervals. The scan intervals allow different data items to 
be transferred at different rates. There are 4 scan classes: A, B, C and D.  The 
intervals for each can be adjusted by entering the scan time in milliseconds. The 
interval must be between 200 milliseconds and 60 seconds. 
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4 Next, configure the link between a DF1 node and File Number to map to a Logix 
tag, and the associated action and scan required.  

 

 

Figure 3.27 – Scheduled Tag Mapping 

 

Parameter Description 

Logix Function Specifies whether the transaction will result in a read or write function from the Logix 

controller’s perspective. 

Scan Specifies the rate of transaction to be executed. Select a scan class letter that 

matches the required interval. Take into account the configured Baud rate and 

message size. 

Device Type Specifies the type of message that will be sent to the DF1 device. There are two 

options: PLC5 and SLC (Use with a MicroLogix device) 

DF1 Node Specifies the remote device’s node. 

Data Address Specifies the remote device’s address - to the element level. For example, N10:0. 

(Note that this differs from the DF1 Slave configuration where only the file is specified) 

Element Count Specifies the number of items to be read or written. In the example above, with a Data 

Address of N10:0 and an Element Count of 5, then N10:0 through N10:4 will read from 

the DF1 device and written to Logix. 

Target Name Configured in the first step, it can be selected by means of the target Name combo 

box.    

Target Tag Either entered manually or selected using the Tag Browser in the PLX50 Configuration 

Utility. The Tag Browser requires the controller to be online. 

Browse When clicked, the Tag Browser dialog opens and scans all the tags inside that 

controller. If the controller has been recently scanned in this session, then a cached 

version of the tags will be displayed. A rescan of the tags can be triggered by selecting 

the REFRESH button in the Tag Browser’s toolbar. Only tags of a relevant type will be 

enabled, select a suitable tag. 
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Note: When mapping PLC5 Boolean files (e.g. B3), it is recommended that the destination Logix tag be a 
SINT array, rather than a Boolean array. Using the latter may result in unexpected results due to the 
packing format of Logix Boolean arrays. 

 

 

Figure 3.28 – Tag Browser tag selection 

 

Note: Ensure the Logix tag array datatype and size matches that of the selected DF1 Data Address. Failing 
to do this can result in communication faults and unexpected results. 
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3.6 Module Download  

Once the DF1 configuration has been completed, it must be downloaded to the module. 

Before downloading, the Connection Path of the module must be set. This path will 
automatically default to the IP address of the module, as set in the module configuration. 
It can be modified if the PLX51-DF1-MSG is not on a local network. 

The Connection Path can be set by right-clicking on the module and selecting the 
CONNECTION PATH option. 

 

Figure 3.29 – Selecting Connection Path 

 

The new connection path can then be either entered manually or selected by means of 
the Target Browser. 

 

Figure 3.30 – Connection Path 
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To initiate the download, right-click on the module and select the DOWNLOAD option. 

 

Figure 3.31 – Selecting Download 

Once complete, a notification dialog indicates a successful download. 

 

Figure 3.32 – Successful download 

During the download process, the module’s time will be compared to that of the PC’s 
time. Should the difference be greater than 30 seconds, a prompt to set the module time 
to match the PC’s time will appear. The module time is used only for the event log. 

 

 

Figure 3.33 – Setting module time 
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Within the PLX50 Configuration Utility environment, the module will be in the Online 
state, indicated by the green circle around the module. The module is now configured 
and in operation.  

 

 

Figure 3.34 – Module online 
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3.7 RSLogix 5000 Configuration 

The PLX51-DF1-MSG module can be easily integrated with Allen-Bradley Logix family of 
controllers. 

For Logix versions 20 and newer, the module can be added using the EDS Add-On-
Profile (AOP), as described on page 38. 

For Logix versions 19 and older), the module must be added using a Generic Profile, as 
described on page 42. 

3.7.1 Studio 5000 Configuration (Version 20+) 

The Logix family in Studio 5000 uses the EDS AOP. Before the module can be added to 
the tree, the module’s EDS file must be registered.  

Using RSLinx, the EDS file can be uploaded from the device. The EDS Hardware 
Installation Tool is then invoked to complete the registration. 

Alternatively, the EDS file can be downloaded from the product web page at 
www.prosoft-technology.com. It can be registered manually using the EDS HARDWARE 

INSTALLATION TOOL shortcut, under the Tools menu in Studio 5000. 

 

 

Figure 3.35 – EDS Hardware Installation Utility 

 

  

http://www.prosoft-technology.com/
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Once the EDS file has been registered, the module can be added to the I/O 

Configuration tree.  

1 Under an ETHERNET bridge module in the tree, select the Ethernet network, right-
click and select the NEW MODULE option. 

 

Figure 3.36 – Adding a module 

2 The Select Module Type dialog opens. To find the module, use the Vendor filter 
to select the PROSOFT TECHNOLOGY modules as shown in the figure below. 

 

 

Figure 3.37 – Selecting the module 
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3 Locate and select the PLX51-DF1-MSG module, and select the CREATE option. 
In the New Module dialog, specify the Name and IP Address as a minimum to 
complete the instantiation. 

 

 

Figure 3.38 – Module instantiation 

4 Once the instantiation is complete, the module appears in the Logix IO tree. 

 

 

Figure 3.39 – Logix IO tree 
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5 The Module Defined Data Types are automatically created during the 
instantiation process. These data types provide meaningful structures to the 
module data. An excerpt of the Input Image is shown in the following figure.  

 

Figure 3.40 – Module Defined Data Type 
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3.7.2 RSLogix 5000 Configuration (Pre-Version 20) 

3.7.2.1 Add Module to I/O Configuration 

The module can operate in both a Logix “owned” and standalone mode. When operating 
in “owned” mode, the PLX51-DF1-MSG must be added to the RSLogix 5000 I/O tree as 
a Generic Ethernet Module.  

1 Right-click on the ETHERNET bridge and select NEW MODULE. Select the 
ETHERNET-MODULE as shown in the figure below.  

 

 

Figure 3.41 – Add a Generic Ethernet Module in RSLogix 5000 

2 In the Module Properties dialog, enter the Name, IP Address, and Connection 
Parameters. Below are the required connection parameters. 

Connection Parameter Assembly Instance Size 

Input 100 34 (32-bit) 

Output 101 1 (32-bit) 

Configuration 102 0 (8-bit) 

Table 3.3 – RSLogix class 1 connection parameters for the PLX51-DF1-MSG 

 

Figure 3.42 – RSLogix General module properties in RSLogix 5000 
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3 Enter the Requested Packet Interval (RPI). This is the rate at which the input and 
output assemblies are exchanged. The recommended value is 500ms. Click OK. 

Note: Although the module can run with an RPI of 10ms, it is recommended to set the RPI to 
500ms to avoid unnecessary loading of the module processor. 

 

 

Figure 3.43 – Connection module properties in RSLogix 5000 

4 Once the module has been added to the RSLogix 5000 I/O tree, assign the User 
Defined Types (UDTs) to the input and output assemblies. 
 

 

Figure 3.44 – RSLogix 5000 I/O module tree 

5 Import the required UDTs by right-clicking on User-Defined sub-folder in the Data 
Types folder of the I/O tree, and selecting IMPORT DATA TYPE.  

 

 

Figure 3.45 – Import Data Type 

6 Select the data type file, the assemblies are then assigned to the UDTs with a 
ladder copy instruction (COP).  
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3.7.2.2 Importing UDTs and Mapping Routines 

To simplify the mapping of the input image, an RSLogix 5000 Routine (.L5X) file is 
provided. This file can be imported by right-clicking on the required Program and 
selecting the IMPORT ROUTINE option. 

 

 

Figure 3.46 – RSLogix 5000 Importing DF1Messenger specific routine and UDTs 

 

 

Figure 3.47 – Selecting partial import file 
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The import creates the following: 

• The required UDTs (user defined data types) 

• Two controller tags representing the Input and Output assemblies. 

• A routine mapping the PLX51-DF1-MSG module to the aforementioned tags. 

 

To change the routine to map to the correct PLX51-DF1-MSG module instance name, 
make sure the mapping routine is called by the Program’s Main Routine. 

 

 

 
Figure 3.48 – Imported RSLogix 5000 objects 
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4 Operation 

4.1 Message Routing 

When the PLX51-DF1-MSG has been configured, the DF1 message initiator sends a 
read/write to a DF1 address, then routed to a Logix tag. There are various indicators to 
determine if the mapping has correctly routed the DF1 messages. Refer to the 
Diagnostics chapter on page 48 for a more information. 

4.2 RSLogix 5000 Assemblies 

When the module operates in a Logix “owned” mode, the Logix controller establishes a 
class 1 cyclic communication connection with the PLX51-DF1-MSG. An input and output 
assembly is exchanged at a fixed interval. The UDTs convert the input and output arrays 
into tag-based assemblies.  

 

 

Figure 4.1 – Input assembly UDT structure 
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4.2.1 Input Assembly 

The following parameters are used in the input assembly of the module: 

 
Parameter Datatype Description 

Instance STRING The instance name of the module that was configured 

under the general DF1 configuration in the PLX50 

Configuration Utility. 

Status.Reserved BOOL Reserved 

Status.ReactiveTagMode BOOL Set if the module is operating in DF1 Slave mode. 

Status.ScheduledTagMode BOOL Set if the module is operating in Scheduled Tag mode. 

Status.ConfigurationValid BOOL Set if a valid configuration is executing in the module. 

Status.RoutingInhibited BOOL Set when the module’s routing function has been 

inhibited. Routing can be inhibited by setting a bit in the 

output assembly of the module. 

Status.ScheduledTagStatus0 

to 19 

BOOL[20] Each bit represents the status of the last scheduled 

transaction for that specific map item. A true value 

indicates success.   

TransactionRate DINT The transaction rate is the number of DF1 messages per 

second that the module is currently routing. 

Temperature REAL The internal temperature of the module. 

DF1RxPacketCount DINT The total number of DF1 packets received by the module. 

DF1TxPacketCount DINT The number of DF1 packets sent by the module. 

DF1ChecksumErrors DINT The number of corrupted DF1 packets received by the 

module. 

PCCCRequests DINT The total number of DF1 message routing requests 

received by the module when operating in Bridge mode. 

PCCCFailures DINT The total number of DF1 message routing requests that 

resulted in errors when operating in Bridge mode.  

TagReads DINT The total number of tag reads executed by the module 

when operating in Tag Map mode. 

TagWrites DINT The total number of tag writes executed by the module 

when operating in Tag Map mode. 

TagConnectionFailures DINT The number of failed class 3 connection attempts when 

operating in Tag Map mode.  

Tag reading and writing requires the module to first 

establish a class 3 connection with the Logix Controller.  

TagErrors DINT The number of failed tag access (read/write) requests 

when operating in tag Map mode. 

These may include privileged violations, non-existing tags, 

etc. 

Table 4.1 – RSLogix 5000 input assembly parameters 

4.2.2 Output Assembly 

The following parameters are used in the output assembly of the module. 

 
Parameter Datatype Description 

RoutingInhibit BOOL This bit inhibits the module’s routing capabilities.  

When set, no DF1 messages are routed. This may be 

required in applications running a redundant DF1 network 

where one of the PLX51-DF1-MSGs is to run in a hot-standby 

mode. 

Table 4.2 – RSLogix 5000 output assembly parameters 
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5 Diagnostics 

5.1 LEDs 

The PLX51-DF1-MSG provides three LEDs for diagnostic purposes. 

 

 

Figure 5.1 – PLX51-DF1-MSG front view 

 
LED Description 

Ok The Ok LED provides information regarding the system-level operation of the module. 

If the LED is red, the module is not operating correctly. For example, if the module 

application firmware has been corrupted or there is a hardware fault the module will 

have a red Module LED.  

 

If the LED is green, then the module has booted and is running correctly. 

Act The Activity LED is used for the RS232 serial port. Every time a successful DF1 

packet was received, the LED will toggle green. The LED toggles red if a corrupted 

packet was received (eg. failed checksum). 

Eth The Ethernet LED illuminates when an Ethernet link has been detected (by plugging in 

a connected Ethernet cable). The LED flashes when traffic is detected. 

Table 5.1 – Module LED operation 
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5.2 Module Status Monitoring 

The PLX51-DF1-MSG provides statistics that can assist with module operation, 
maintenance, and diagnostics. The statistics can be accessed in full by the PLX50 
Configuration Utility or using the web server in the module.  

To view the module’s status in the ProSoft PLX50 Configuration Utility, the module must 
be online. Right-click on the module and select the GO ONLINE option. 

 

 

Figure 5.2 – Selecting to Go Online 

 

The Online mode is indicated by the green circle behind the module icon in the Project 
Explorer tree. 

 

Figure 5.3 – Selecting online Status 
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The Status dialog can be opened by either double-clicking on the STATUS item in the 
Project Explorer tree, or by right-clicking on the module and selecting STATUS. 

 

 

Figure 5.4 – Status monitoring - General 

 

5.2.1 General Tab 

The General tab displays the following general parameters. It can also be used to set the 
module time to the PC time:  

Parameter Description 

Mode Indicates the current operating mode:  

• DF1 Slave 

• Scheduled Tag 

Owned Indicates whether or not the module is currently owned (Class 1) by a Logix controller. 

Routing Indicates whether the routing of the module is enabled or inhibited. The routing 

operation can be inhibited in the output assembly of the module. 

Transaction Rate The number of DF1 messages per second that the module is currently routing. 

Up Time Indicates the elapsed time since the module was powered-up. 

Module Time Indicates the module’s internal time. The module time is stored in UTC (Universal 

Coordinate Time) but displayed on this page according to the local PC Time Zone 

settings. 

MAC Address Displays the module’s unique Ethernet MAC address. 

Temperature The internal temperature of the module. 

Processor Scan The amount of time (microseconds) taken by the module’s processor in the last scan. 

DIP Switches - 

Position  

The status of the DIP switches when the module booted. 

Note that this status will not change if the DIP switches are altered when the module is 

running. 

Table 5.2 – Parameters displayed in the Status Monitoring – General Tab  
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5.2.2 Transactions Tab 

The Transactions tab displays the following statistics for: 

• DF1 messages 

• Bridge messages (Not relevant for the DF1 Messenger) 

• Logix Tag Mapping (DF1 Slave and Scheduled Tag Mode) 

 

 

Figure 5.5 – Status monitoring - Transactions 

 
Statistic Description 

Tx Packet Count The number of DF1 packets sent by the module. 

Rx Packet Count The number of DF1 packets received by the module. 

Checksum Errors The number of corrupted DF1 packets received by the module. 

STX Count The number of DF1 STX (Start of Text) delimiters received by the module. 

SOH Count The number of DF1 SOH (Start of Header) delimiters received by the module. 

NAK Count The number of NAK (Negative Acknowledge) DF1 packets received by the 

module. 

ACK Count The number of ACK (Acknowledge) DF1 packets received by the module. 

ENQ Count The number of ENQ (Enquiry) DF1 packets received by the module. 

Unknown Count The number of unknown packets received by the module. 

Parity Errors The number of bytes with parity errors received by the module. 

Duplicate Packets The number of duplicate packets received by the module. 

Table 5.3 – DF1 statistics 
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The following PCCC statistics are not relevant for the PLX51-DF1-MSG. 

Statistic Description 

PCCC Requests The number of EtherNet/IP PCCC requests that have been sent to a Logix 

controller. 

PCCC Failures The number of failed EtherNet/IP PCCC responses that have been received by the 

PLX51-DF1-MSG from a Logix controller. 

Current Sessions The current number of open EtherNet/IP PCCC sessions. 

Table 5.4 – PCCC statistics 

 

The following Tag Mapping statistics are only relevant when the module is running in 
either DF1 Slave or Scheduled Tag mode. 

Statistic Description 

Current Connections  The number of current open class 3 connections. 

Connection Failures The number of failed attempts at establishing a class 3 connection with a Logix 

controller. 

Tag Not Exist Errors The number of tag read and tag write transactions that failed due to the 

destination tag not existing. 

Privilege Violation 

Errors 

The number of tag read and tag write transactions that failed due to a privilege 

violation error.  

This may be caused by the External Access property of the Logix tag being set 

to either None or Read Only. 

Tag Reads The number of tag read transactions executed by the PLX51-DF1-MSG 

module. 

Tag Writes The number of tag write transactions executed by the PLX51-DF1-MSG 

module. 

CIP Timeout This count increases when no response was received for the Tag Read/Write. 

ENIP Retries This count increases when no response was received from the Logix Controller 

by the time the ENIP timeout is reached. 

ENIP Failures This count increases when the ENIP Retry Limit is reached and no response 

has been received from the Logix Controller. 

Table 5.5 – Tag Mapping statistics 
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5.2.3 Map Items Tab 

The Map Items tab displays the successful packet counts processed by each mapping 
item. If an item count changes, the Success Count field will be displayed with a green 
background for approximately 3 seconds. This provides quick visual feedback of the 
currently active items. 

 

The fields in the Map Items tab adjust to suit the appropriate mode. 

 

Figure 5.6 – Map Item status 
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5.3 DF1 Packet Capture 

The module provides the ability to capture the DF1 traffic for analysis.  

To invoke the capture, double-click on the DF1 PACKET CAPTURE selection in the Project 
Explorer tree. 

 

Figure 5.7 – Selecting DF1 Packet Capture 

The DF1 Packet Capture dialog opens and automatically starts capturing all DF1 
packets.  

Note: The module keeps a circular buffer of the last 20 DF1 packets, there may be up to 20 packets in the 
capture that were received / sent before the capture was initiated. 

 

 

Figure 5.8 – DF1 packet capture 
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To display the captured DF1 packets, the capture process must first be stopped by 
pressing the STOP button. 

 

 

Figure 5.9 – DF1 Packet Capture complete 

 

The captured DF1 packets are tabulated as follows: 

Statistic Description 

Index  The packet index, incremented for each packet sent or received. 

Time The elapsed time since the module powered up. 

Status The status of the packet. Received packets are checked for valid DF1 constructs and 

valid checksums. 

Dirn     The direction of the packet, either transmitted (Tx) or received (Rx). 

Src      DF1 node address of the message source. 

Dest    DF1 node address of the message destination. 

Description Brief description of the packet, usually the command. 

Address The string representing a PLC data address, where applicable. 

Detail Additional details associated with command. 

TNS Transaction number used to match the request and reply messages. 

Data The packet’s raw data displayed in space delimited hex. 

Table 5.6 – DF1 Packet Capture fields 
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The packet capture can be saved to a file for further analysis by selecting the SAVE 
button on the toolbar. Previously saved DF1 Packet Capture files can be viewed by 
selecting the DF1 PACKET CAPTURE VIEWER option in the Tools menu. 

 

 

Figure 5.10 – Selecting the DF1 Packet Capture Viewer 
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5.4 Module Event Log 

The PLX51-DF1-MSG module logs various diagnostic records to an internal event log. 
These logs are stored in non-volatile memory and can be displayed using the PLX50 
Configuration Utility or via the web interface. To view the logs in the PLX50 
Configuration Utility, select the EVENT VIEWER option in the Project Explorer tree. 

 

 

Figure 5.11 – Selecting the module Event Log 

The Event Viewer dialog opens and automatically reads all the events from the module. 

The log entries are displayed with the latest record at the top. Custom sorting is 
achieved by double-clicking on the column headings. 

 

 

Figure 5.12 – Module Event Log 

The log can also be stored to a file for future analysis, by selecting the SAVE button in 
the tool menu.  

To view previously saved files, use the EVENT LOG VIEWER option under the Tools menu.  
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5.5 Web Server 

The PLX51-DF1-MSG provides a web server allowing a user without the PLX50 
Configuration Utility or RSLogix 5000 to view various diagnostics of the module. This 
includes Ethernet parameters, system event log, advanced diagnostics, and application 
diagnostics (DF1 diagnostics). 

Note: The web server is read-only and thus no parameters or configuration can be altered from the web 
interface. 

 

 

Figure 5.13 – Web interface 
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6 Technical Specifications 

6.1 Dimensions 

Below are the enclosure dimensions as well as the required DIN rail dimensions. All 
dimensions are in millimeters. 

 

 

Figure 6.1 – PLX51-DF1-MSG enclosure dimensions 

 
 

 

Figure 6.2 – Required DIN dimensions 
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6.2 Electrical 

Specification Rating 

Power requirements Input: 10 to 28V DC, (70 mA @ 24 VDC / 130 mA @ 10 VDC)  

Power consumption 1.7 W 

Connector 3-way terminal 

Conductors 24 to 18 AWG 

Enclosure rating IP20, NEMA/UL Open Type 

Temperature -20°C to 70°C 

Earth connection Yes, terminal based 

Emissions IEC61000-6-4  

ESD Immunity EN 61000-4-2 

Radiated RF Immunity IEC 61000-4-3  

EFT/B Immunity EFT: IEC 61000-4-4  

Surge Immunity Surge: IEC 61000-4-5 

Conducted RF Immunity IEC 61000-4-6  

Table 6.1 – Electrical specification 

6.3 Ethernet 

Specification Description 

Connector RJ45 

Conductors CAT5 STP/UTP 

ARP connections Max 20 

TCP connections Max 20 

CIP connections Max 10 

Communication rate 10/100Mbps 

Duplex mode Full/Half 

Auto-MDIX support Yes 

Table 6.2 – Ethernet specification 

6.4 DF1 

Specification Rating 

Connector 4-way terminal 

Conductor 24 to 18 AWG 

Isolation voltage 2.5 kV 

Protocol DF1 Full Duplex, DF1 Half Duplex, DF1 Radio Modem 

BAUD 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200 

Parity None, Even, Odd 

Data bits 8 

Stop bits 1 

Error detection CRC, BCC 

Embedded response Auto, On 

DF1 Slave mode  Max 20 mapping items 

Scheduled Tag mode  Max 20 mapping items 

DF1 Slave Mode Message 

Support 

PLC-5 Typed Read, PLC-5 Typed Write, SLC Typed Read, SLC Typed Write, PLC-2 

Unprotected Read, PLC-2 Unprotected Write, PLC-2 Unprotected Bit Write 

Scheduled Tag Mode 

Message Support 

PLC-5 Typed Read, PLC-5 Typed Write, SLC Typed Read, SLC Typed Write 

Table 6.3 – DF1 specification 

6.5 Agency Approvals and Certifications 

Please visit our website: www.prosoft-technology.com 

https://www.prosoft-technology.com/


PLX51-DF1-MSG  Support, Service & Warranty 
DF1 Messenger  User Manual 
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7 Support, Service & Warranty 

7.1 Contacting Technical Support 

ProSoft Technology, Inc. is committed to providing the most efficient and effective support 
possible. Before calling, please gather the following information to assist in expediting this 
process: 

1 Product Version Number 
2 System architecture 
3 Network details 

 

If the issue is hardware related, we will also need information regarding: 

1 Module configuration and associated ladder files, if any 
2 Module operation and any unusual behavior 
3 Configuration/Debug status information 
4 LED patterns 
5 Details about the interfaced serial, Ethernet or Fieldbus devices 

Note: For technical support calls within the United States, ProSoft Technology’s 24/7 after-hours phone support is 
available for urgent plant-down issues.  

North America (Corporate Location) Europe / Middle East / Africa Regional Office 

Phone: +1.661.716.5100 
info@prosoft-technology.com 
Languages spoken: English, Spanish 
REGIONAL TECH SUPPORT 
support@prosoft-technology.com 

Phone: +33.(0)5.34.36.87.20 
france@prosoft-technology.com 
Languages spoken: French, English 
REGIONAL TECH SUPPORT 
support.emea@prosoft-technology.com 

Latin America Regional Office Asia Pacific Regional Office 

Phone: +52.222.264.1814 
latinam@prosoft-technology.com 
Languages spoken: Spanish, English 
REGIONAL TECH SUPPORT 
support.la@prosoft-technology.com 

Phone: +60.3.2247.1898 
asiapc@prosoft-technology.com 
Languages spoken: Bahasa, Chinese, English, 
Japanese, Korean  
REGIONAL TECH SUPPORT 
support.ap@prosoft-technology.com 

 

For additional ProSoft Technology contacts in your area, please visit: 
www.prosoft-technology.com/About-Us/Contact-Us. 

7.2 Warranty Information 

For complete details regarding ProSoft Technology’s TERMS & CONDITIONS OF SALE, 
WARRANTY, SUPPORT, SERVICE AND RETURN MATERIAL AUTHORIZATION 
INSTRUCTIONS, please see the documents at: 
www.prosoft-technology/legal 

 

https://www.prosoft-technology.com/About-Us/Contact-Us
https://www.prosoft-technology.com/ProSoft-Technology-Legal-Terms-and-Conditions

